BlockCAD

Logiciel gratuit de modélisation de constructions Légo
Anders Isaksson
http://user.tninet.se/~hbh828t/proglego.htm
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Mode d'emploi

(traduit de I'anglais par Wilfrid Pochat)
(Derniére mise 2 jour: 16-06-2003)

« Comme le programme a été réalisé a 1'origine pour mes enfants, il y a trés peu de texte. L'utilisateur
devra composer avec les nombreux boutons et icones a la place.

You pouvez réaliser des constructions en utilisant les briques standards, les briques toits et les briques
spéciales comme celles représentant des fenétres et des portes. Vous pouvez choisir la couleur de
chaque piece et méme la modifier par la suite.

La premiere facon d'assembler les briques est d'utiliser la souris en les sélectionnant dans la fenétre de
droite puis en les déplagant dans la fenétre de visualisation. En mode normal ("Safe mode" en anglais),
chaque brique se place par dessus une brique précédente. Il est impossible de la placer dans les airs ou
entre deux autres briques. Le mode normal peut étre annulé a partir du menu de configuration (Icone
Roulement). »



La barre d'outils située en haut du programme
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_G_ Quitte le programme
G

= Commence une nouvelle construction

2" Ouvre une construction enregistrée ou un sous-assemble a ajouter

H

=7 Enregistre une construction ou la sélection d'un ensemble

" Sélectionne une partie de la construction et 1'enregistre sous forme d'image au format BMP ou
JPG

.= Imprime une simple copie d'écran

S

™ Menu pour configurer le logiciel

d) ‘9‘9‘ d;’ Modifie I'angle de vue de la construction

.= Affiche ou non les points de fixation sur les briques (studs). Accélere la modélisation sur de vieux
PC quand l'option No Studs est sélectionnée.

5

.= Remplit ou non les faces de la construction. La encore, la modélisation est plus rapide si aucun
rendu n'est a réaliser sur les faces.

s
L Apercu 2D depuis la base.

s Grossit ou rétrécit la vue de la construction a 1'écran.

>

=" Redessine la construction a I'écran. Cela peut-€tre nécessaire apres utilisation lorsque 1'option Z-
level n'est pas sélectionnée.

B Permet d'abandonner le mode insertion de briques (NDT : la touche [Echap] agit de la méme
facon).

o . . . .

" Rend transparentes les briques (NDT : utile pour simuler des vitres).
.7 Affiche ou non les points de fixation sur les briques a sélectionner
i Permet de choisir quelle couleur appliquer a la surface des briques

Adresse de l'auteur du programme (Anders Isaksson) et liste des personnes qui I'ont aidé a
améliorer le logiciel.




La barre d'outils située en bas du programme
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. Briques vues de dessus
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-> Blocs vus selon des angles prédéfinis
Briques vues de coté

® Restaure I'angle de vue initial de la construction tel qu'il avait été enregistré

IN I "’I
JDL Permet de modifier la taille des points de fixation. Normal pour des points complets, Halp
pour la moiti¢ et Fine pour 1/24 éme

19999 . . . oo c PERTINP
[ L'option Z-level. Permet d'afficher une a une les différentes étapes de la réalisation.

Utile quand il s'agit de faire un réajustement une fois que la construction a été achevée.

Base: 16 X 4§ . . . . . . ..
Dimensions de la base en nombre de points de fixation. Si vous saisissez 0 pour 1'un

des deux nombres, cela a pour effet de supprimer la base. Appuyez sur la touche [Entrée] pour valider
la saisie.

! Sélectionne la hauteur de la base entre deux modeles (haute ou courte)

La barre d'outils située sur le c6té droit
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IR W U clic gauche sélectionne la couleur des briques, un clic droit sélectionne la
couleur du fond de la fenétre de visualisation.
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-> Sélectionne les différentes collections de briques disponibles
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5001 -> Un clic gauche sélectionne la brique en mode insertion. I suffit de la faire
ezl glisser a I'endroit désiré dans la fenétre de visualisation. Un clic droit fait
apparaitre un menu contextuel pour éditer la piece.

Opérations a I'aide de la souris dans la fenétre de visualisation

Clic gauche + Touche [Majuscule] -> Sélectionne une brique de la construction pour la déplacer.
Attention, quand le mode sécurité (Safe Mode) est actif (il I'est par défaut), la brique sélectionnée une
fois déplacée sera positionnée par dessus les autres briques.



Clic gauche -> Permet de sélectionner une ou plusieurs briques (ou groupes de briques). Un autre clic
annule la sélection.

Clic gauche + Touche [Ctrl] -> Sélectionne ou désélectionne une brique au niveau d'un groupe de
briques.

Clic gauche + Touche [Majuscule] + Touche [Ctrl] -> Coupe 1'ensemble des briques sélectionnées
afin de les déplacer et les positionner a 1'endroit de votre choix.

Clic gauche + Touche [Majuscule] + Touche [Alt] -> Copie I'ensemble des briques sélectionnées afin
de les déplacer et les reproduire a volonté.

Clic droit -> permet de la faire pivoter la brique en cours d'assemblage ou le sous-assemble
sélectionné. Si vous ne déplacez pas de brique, permet de changer la couleur de la brique désignée.

Clic droit + Touche [Ctrl] -> Fait pivoter de 90° la brique sélectionnée.

Touche droite [Majuscule] + Clic droit souris -> Fait pivoter le modele tout comme les fleches
bleues du sommet.

Clic droit + Touche [Alt] -> Affiche ou non les tenons.

Opérations a l'aide des touches du clavier

[Delete] ou [Suppr] -> Efface toutes les briques sélectionnées.

[Backspace] ou [Retour Arriere] -> Efface la brique en cours d'utilisation

[Escape] ou [Echap] -> Désélectionne les briques sélectionnées.

Touches fléchées -> Déplace la brique en cours d'utilisation d'une position X ou Y.
[Shift] + touches fléchées -> Déplace la brique en cours d'utilisation d'un tenon X ou Y.
[Insert] -> Fait pivoter la brique en cours d'utilisation de 90°.

[Page up/down] -> Déplace la brique en cours d'utilisation d'une position Z (uniquement si l'option
Safe Mode est sur off).

[Shift] + [Page up/down] -> Déplace la brique en cours d'utilisation d'un tenon Z (uniquement si
'option Safe Mode est sur off).

[Enter] ou [Entrée] -> Pose une brique.

[F1] a [F10] -> Correspond aux différents boutons de vue dans la barre du bas.
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™ Le menu Configuration

Advanced Toolbox
Ouvre une boite de dialogue.
Les options de la partie supérieure concernent uniquement les blocs sélectionnés dans la
construction. Si rien n'a été sélectionné, vos réglages n'auront aucun effet. Donc la premiere étape
consiste a sélectionner un ou plusieurs blocs (cf opérations a 1'aide de la souris) .
Studs on/off -> I'ensemble des pieces s'affiche ou pas avec leurs tenons.
Color this piece -> I'ensemble des pieces sélectionnées s'affiche dans la couleur choisie.
Transparent -> Rend transparentes ou opaques les pieces sélectionnées.
Turn -> Fait pivoter I'ensemble des pieces sélectionnées.
Set part id -> Les utilisateurs de Ldraw peuvent poser une brique standard et changer son
numéro de référence. Cela peut s'avérer utile quand on on commence un projet Ldraw dans
BlockCAD.
Set step number -> Associe les pieces sélectionnées a une étape définies par un numéro. Quand
toutes les pieces ont été associées de la sorte, vous pouvez lancer la construction étape par étape
du modele.
X, Y, Z -> Déplace les pieces sélectionnées dans toutes les directions possibles. Toutefois cela
n'est pas sans conséquence car des briques peuvent se retrouver emboitées de fagon curieuse ce
que BlockCAD ne parviendra pas forcément a afficher alors que Ldraw le peut.

Les options de la partie inférieure s'appliquent a I'ensemble de la construction

Replace this color -> A partir de la brique sélectionnée, remplit toutes les autres briques ayant la
méme couleur avec la couleur choisie.

Use this color -> La couleur choisie s'applique a la brique sélectionnée.

Step -> Dans la mesure ol toutes les pieces sont associées a une étape numérotée, vous pouvez
assister a I'élaboration du modele pas a pas.

NOTE pour les utilisateurs de Ldraw : La fonction step est en cours de développement and n'a
pas pour l'instant de lien avec la commande '0 STEP' dans Ldraw. Plus tard probablement.

Si vous cliquez sur le bouton [Edit Ldraw info], la fenétre s'agrandit et vous avez la possibilité
d'éditer le changement entre BlockCAD et Ldraw. Cela est seulement intéressant si vous avez
créé une nouvelle brique que vous voulez voir tracée correctemebt dans Ldraw

Ldraw this view

Ce menu n'est accessible que si vous avez installé Ldraw et avez indiqué le chemin d'acces de
I'application dans le fichier blockcad.ini. Dans ce cas, vous pouvez lancer Ldraw pour effectuer un
rendu du modele en cours dans BlockCAD depuis le méme angle de vue.

NOTE BlockCAD peut afficher des briques qui n'existent pas dans Ldraw — celles-ci seront alors
omises. Il peut également y avoir quelques erreurs dans le fichier bc2ld.lst, auquel cas le rendu ou la
position dans Ldraw ne sera pas juste.

POV (Via L2P)
Si vous avez installé Ldraw, L2P et POVRay, vous pouvez lancer un rendu directement depuis



BlockCAD. Vous aurez besoin de modifier le fichier L2ZPGO.BAT, et de le copier également dans le
répertoire de Ldraw.

POV (Via L3P)

Si vous avez installé Ldraw, L3P et POVRay, vous pouvez lancer un rendu directement depuis
BlockCAD. Vous aurez besoin de modifier le fichier L3PGO.BAT, et de le copier également dans le
répertoire de Ldraw.

Make group

Associe les briques sélectionnées a un groupe. De cette maniere toute brique associée a un groupe se
comporte avec I'ensemble du groupe (ainsi toutes les briques du groupe sont sélectionnées deés qu'on
clique sur I'une d'entre elles). Par contre un clic associ€ a la touche [Ctrl] sélectionne uniquement la
brique visée. L'association d'une brique a un groupe persiste a I'ouverture ou a l'enregistrement d'un
modele. Quand vous insérez un sous assemblage, il se comporte comme un groupe de maniere a
pouvoir étre déplacé entierement lorsqu'il est sélectionné d'un simple clic gauche.

Break group
Cette option est active si au moins un groupe est sélectionné. Cela permet alors de dissocier les briques
du groupe pour les rendre a nouveau indépendantes.

Fast Studs, Better Studs, Best Studs. Permet de choisir entre différentes qualités le rendu des tenons
en privilégiant la vitesse (fast) ou la qualité (best). Cela influence aussi le rendu sous Ldraw.

Safe positioning (default *ON¥)
Activer cette option oblige a ajouter des pieces uniquement par le sommet d'autres pieces. Vous ne
pourrez plus les placer dessous ou a I'intérieur d'un assemblage.

Don't render covered studs (default *OFF*)
Activer cette option peut accélérer le rendu mais il sera nécessaire de recalculer 1'affichage si vous
utilisez la fonction Z-cutoff..

Slow rendering (default *OFF%*)
Redessine 1'image de chaque piece a I'écran. Cette opération est plus ou moins rapide en fonction des
capacités de votre machine.

Restore background color
Restaure la couleur du fond d'écran définie par défaut dans les parametres de Windows. Normalement
cette couleur n'est pas accessible dans BlockCAD.

Background picture...
Selectionne une image a afficher en fond d'écran. Appuyer sur [Cancel] dans le sélecteur de fichiers
enleve 1'image du fond d'écran.

Hints.
Affiche ou non les aides contextuels lorsque la souris se positionne sur un bouton.



Shading.
Permet d'afficher ou non le rendu des ombres.

Adjust light.

Ajuste la position de la source lumineuse.

NOTE: le comportement du rendu de 'ombre indique que vous avez toujours deux sources lumineuses
opposées l'une par rapport a I'autre. Donc si la lumiere brille principalement sur le dessus, le dessous
est aussi allumé.

Le menu Configuration des blocs

Ce menu contextuel est accessible par un clic droit sur le sélecteur de blocs.
Avant d'essayer une seule de ces commandes, il est fortement recommandé de faire une copie de
sauvegarde du fichier BLOCKCAD.INI et du dossier PARTS. En cas de probleme, il vous suffira de les

restaurer..

Edit -> Edite la brique.

Add -> Permet d'ajouter une nouvelle brique a partir de celle qui a été sélectionnée.

Remove -> Supprime une brique de la page.

Add page -> Ajoute une nouvelle page vide.

Add page from file... -> Lit un fichier au format .dat contenant des définitions de briques et les ajoute
dans une nouvelle page.

Remove page -> Supprime la page complete si toutes les briques ont été préalablement supprimées.
Properties -> Permet d'ajuster la hauteur des cellules et de 1a méme maniere 1'échelle de la page.
Reorder pages... -> Permet de modifier I'ordre des pages.

Customize pages... -> Permet de déplacer des briques entre différentes pages.



